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Mountain Lion – New Apps 
Finder and General GUI: Several things are new here, particularly from Snow Leopard. 
Menu bar is about the same, except the notification menu at the extreme right. 
Dock indicators for in-use applications is different, separator is simpler and has similar function. Right-click has 

a couple useful items in contextual menu. 
Scrolling long file names in icon view (in a window or on the desktop) 
Finder Windows: No grow box in the lower right corner of windows. You can now resize a window by any 

edge to resize it. Watch the cursor change, including at the corners and the top edge. This useful new 
interface came with Lion. In fact, if you are careful, you can move a window by an edge, not just by its title 
bar, but it’s a little tricky. Say you move your cursor to the left edge of a window, and your cursor becomes 
a double-headed arrow left to right. If you pause and then drag perpendicularly to the cursor up or down in 
this case, then you move the window rather than resize. 

The Finder windows used to have a lozenge looking button on the right of the title bar that would hide the 
sidebar and toolbar which had the convenient effect, besides saving screen real estate, of forcing the 
opening of another window with the contents of a double-clicked folder. This would make moving files 
and folders around easy. Now you have to use the View menu and select Show/Hide Toolbar or use the 
keyboard shortcut command-option-t. Curious, but the menu item or the keyboard shortcut not only toggles 
the toolbar, but it also toggles the sidebar, so it’s not named correctly. You can’t show the sidebar in a 
window without a toolbar. 

New Share button in toolbar is handy. Choices are ‘Email’, ‘Message’ or ‘AirDrop,’ if both machines are 
capable. Message could be of the iChat to a computer nature or as a MMS to a cellphone. 

Arrange button is new from Lion, lets you group your files instead of a basic alphabetical or chronological list. 
Backing up old files, now separated by date ranges, makes things a tad easier. Maybe grouped by size 
could be helpful in finding files or in conjunction with calculate folder size, where you are wasting space. 

The sidebar icons are no longer in color. There used to be a disclosure triangle to hide a group of icons in the 
sidebar, say the FAVORITES. Now if you hover your cursor just to the right of the group name, a button 
appears, like Hide and goes away when you move your cursor away. You have to remember this if you 
want to reveal the group contents again, because if you hover in the right spot again, you get Show. You 
can drag to rearrange the groups (new in Mountain Lion) and within a group, you can drag to rearrange the 
entries. I’d put the important ones closer to the top, because if you resize the window too short, you won’t 
be able to see the lower entries without scrolling the sidebar contents.  

One of the new items you’ll find in Lion and Mountain Lion’s sidebar, under the favorites group, is All My 
Files. Normally viewed by type. Now I could see how this might be useful for first time users, but I have 
well over three thousand files it considers to be human-useful files. The selection includes files in my home 
folder and iCloud. It ignores files elsewhere, like other directly connected hard drives. Personally I would 
suggest removing it from your sidebar as a distraction to getting serious work done. You used to be able to 
drag a favorite file to the sidebar favorites but you can’t anymore. You can drag a folder there. Another 
thing missing is the group of saved searches; that got excised with Lion. You can resize the sidebar by 
dragging the dividing line left or right. If you drag it all the way to the left, it will snap close, hiding the 
sidebar, which can only be restored from the View menu Show Sidebar or it’s keyboard shortcut 
command-option-s. There used to be a set of saved searches, like Today and if you saved more custom 
searches they would appear below these. There is no longer a separate group of searches and any custom 
saved search shows up with a gear icon among your favorites. To avoid accidentally dragging out icons 
from the sidebar, you now have to either command-drag them out or right-click and select ‘Remove from 
Sidebar’ from the contextual menu.  

You used to have to use the command key in conjunction with clicking on the title of a Finder window to get its 
path. Now you can also control-click or right click it, but it’s just easier to use the View menu Show Path 
Bar. You do know about the proxy icon in the title bar, dragging it where you need it, like into a open or 
save as dialog box to move the focus there. 
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Really annoying is the new action of a Finder window when you copy something from one window to another. 
Say you were looking at a vertically scrolled list view of a folder, say looking at files starting with the letter 
T, and you drag in a new file from somewhere else. It now auto-scrolls back to the top for no apparently 
good reason. You have to scroll back there to see the next item where you left off. 

The home folder’s Library folder became hidden by default in Lion and continues to be hidden in Mountain 
Lion. You can still get to it in the Finder by holding down the option key and selecting it from the Go 
menu. Apple doesn’t want you messing around in there, but you may need to copy in or out some 
important stuff like your Contacts (formerly Address Book) file, your Safari bookmarks, cookie file and 
your email. 

If you are downloading something from a web site, while it’s downloading, the Finder will show it’s 
modification date as Jan. 24, 1984, the Mac’s introduction date. Also there will be a progress bar in the size 
column. There also will be a progress bar in the Downloads folder icon in the Dock. Safari 6 no longer has 
an independent Downloads window, which I don’t prefer, just a little icon in its toolbar. That also shows a 
progress bar during a download. Click on it to reveal the download list. Click a completed download’s 
magnifying glass to reveal that item in the Finder. Double-click on the name to open that file 

The Finder’s menu bar is mostly unchanged, however the Go menu now features the All My Files option, 
which I mentioned before as being less then useful for all but the very beginner. It also has the AirDrop 
option. Of course AirDrop is only useful if you have more than one Mac. There is no support for AirDrop 
under iOS. Mountain Lion has an improved interface for AirDrop file transfers (via WiFi) relative to the 
first AirDrop window introduced with Lion by way of the Share toolbar button in addition to this window. 
Here's Apple's official list of AirDrop supported Macs, which is more restrictive than the Mountain Lion 
requirements themselves:  
• MacBook Pro (Late 2008 or newer) 
• MacBook Air (Late 2010 or newer) 
• MacBook (Late 2008 Aluminum or newer) 
• iMac (Early 2009 or newer) 
• Mac mini (Mid 2010 or newer) 
• Mac Pro (Early 2009 w/AirPort Extreme card, or Mid 2010 or newer) 

Spotlight has a couple of new tricks. One I found useful is it can search for files based on the website they were 
downloaded from. If you are a fan of the menubar spotlight search, reached by clicking or command-space, 
after you type-in a search criteria, the top hit is highlighted. You can just press return to open that file or 
application. You can press the escape to erase your search criteria and again to exit out of Spotlight. You 
may help direct your search with a keyword, for example kind:font Helvetica will limit your results to just 
font files and exclude any other kind of file that includes Helvetica in their content. I tend to search and 
then Quick Look for files when I don’t recall the name. Just thought I’d add something here, not related to 
Mountain Lion. SneakPeek Pro is a Quick Look plug-in that adds the ability to Quick Look inside .ai and 
.indd Illustrator and InDesign files and .eps files and it’s only 20 bucks. 

. 
Apple included Applications 
Some programs, like Mail and Safari have a pair of diagonal arrows in the top-right corner. This is the way to 

enter full-screen mode. For the record, I don’t like this. I want to do more than one thing at a time, not hide 
everything else. What am I, a 4 year old or a 90 year old who will get confused? Anyway, even the menu 
bar is hidden by your supersize window until you move your cursor up there. You may notice in Safari that 
even the toolbar and button bar get hidden too. At least if you have two or more tabs open, they are 
retained. Luckily a quick tap of your esc key gets you out of that. If you forgot about your escape key, then 

maybe you will notice the blue icon  at the extreme right, even past the notification 
menu, if you move your cursor to the top of the screen in an attempt to get back to normal. Clicking on that 
will also exit the full-screen mode. Another note of how bad this feature is, if you have two displays, the 
other one is blanked with the gray linen design, so they really want you to concentrate on one application 
window. The only person who probably likes this function has a 11-inch MacBook Air with its 1366 x 768 
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resolution screen and you need to make use of every pixel. There is a bit of cheat for full screen mode, if 
you need to see the menu bar briefly. The command-space shortcut for Spotlight will bring that up and the 
menu bar. At least you can check the time or WiFi signal strength. Apple has decided only some apps need 
full screen mode: Contacts, FaceTime and TextEdit lack it. App Store, Calendar, Chess, Preview, and 
Safari have it. 

The App Store application now serves double duty as mentioned before regarding it’s new responsibility to 
include what used to be System Update. Just click on the Updates icon in the toolbar to start a search for 
any updates. Then you can click the Update All button. As the updates download, you can see a progress 
bar under the Launchpad application icon in the Dock. 

Calendar replaces good old iCal. Alphabetically then, this is the first program featuring skeuomorphic design 
elements. Don’t ‘ya just live jargon? That just means something designed to look like a real item, for no 
good reason except familiarity. Call it cutesy if you prefer. Do we really need the torn paper residue? 
Anyway, we now have iCloud categories, to sync with the various calendars available on your iPad. The 
iPhone’s Calendar app doesn’t waste pixels on this design element. Anyway, we come finally to a reason to 
upgrade to Mountain Lion. It syncs with your iPad and iPhone over the Internet. Of course if you signed up 
for a free Google or Yahoo! account, you could have already been doing this. Just have to make the Gmail 
account your default so when you quickly make an appointment, it will sync up. It all uses the same 
CalDAV subscriptions that Apple has been using for years and in offices with a Mac OS X Server featuring 
iCal Server since Mac OS X 10.5. The new Year view highlights each day with events. It’s color coded, 
yellow for one event per day, light orange for two events, darker orange for three events and red for four or 
more events, a busy day. Calendar loses the ability to create To Do items. Apple has created a new 
application for these, Reminders. This syncs with the Reminders app in iOS, first introduced with iOS 5. 

Reminders is a new app on the Mac. Even though it syncs with your iPhone, I don’t see much use for it as you 
already have the Calendar app. About the only thing it does differently is offering a checkbox for 
completed tasks and a count of completed tasks. It builds a new category list of completed reminders. You 
could just remove the completed events from the calendar. This method in Reminders is better for things 
that are not time based. Apple likes to show a shopping list, but any procedure involving a series of steps 
could be tracked with this application. You can right-click on a reminder list name on the left and select 
rename or Delete. Heck, you could send a coworker a list of things to buy a MicroCenter and take 
advantage of iCloud, add a few last minute items. You can put in a URL or an email address, but you can’t 
drag in a file for reference. Again this sort of thing could have been done before, and Reminders can 
include info from a google and/or yahoo! as well. What IS cool is the location based reminders. You can 
set up a reminder whenever you leave or arrive at some location. Not useful for a Mac Pro or a iMac, but 
useful for MacBooks or your iPhone. This is one of those apps that will trigger the Privacy System 
Preference which can note which applications have requested your location in the past day. 

Contacts replace Address Book and it’s also skeuomorphic in Mountain Lion. It’s much like before. You can 
have it sync via iCloud or google or yahoo. If you have a Mac server, it can sync with that and if you have 
a Mac in a Window’s centric office, it can sync with Microsoft Exchange. You will of course want to set 
up iCloud as the default account if you want your contacts to sync to your iPhone. 

Dashboard is the same as it’s always been. 
Dictionary is also the same as before, standard Dictionary based on the New Oxford American Dictionary, as 

well as Thesaurus based on the Oxford American Writer’s Thesaurus. You also have a Wikipedia and now 
there is the Apple Dictionary with useful technical terms like Thunderbolt and FireWire. Should be useful 
for newbies to keep up with my Q&A column in the Forum. 

DVD Player is basically the same, with a refreshed menu structure and supports full screen mode. 
FaceTime is also unchanged despite having it’s version updated to 2.0 
Font Book is basically the same as before. There are four small icons in the toolbar that become active when 

you select a specific font, where you can switch between the various preview styles. I like to change the 
preferences to resolve duplicates by moving to the Trash as Font Book would still complain about 
duplicates even if one was disabled. Its better at select the correct one to kill when resolving duplicates than 
older versions. I turn on Automatic font activation and turn off un-needed fonts like the various foreign 
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language choices included. You’d be surprised how many there are and how much faster your Mac will be 
without them enabled. 

Game Center – Sign up and compete with your friends who play online games that are registered with game 
center. You can find more friends by linking to Facebook. Analogous to the iOS app of the same name. 
There are far more Game Center enabled games for iOS than OS X. 

Image Capture. Nothing new here, it’s a basic program to capture your images from your Apple supported 
scanner. Click Show Details for more control. It can also capture audio from your digital camera. It retains 
different settings for each device. 

Launchpad is the best example of how Apple is making the Mac more like the iPad. It’s a full screen app all 
the time and responds just like a iPad would, with pages full of a grid of application icons. There is a 
search field at the top. If you owned a iPad for a while before buying a Mac, you may like this. If not, and 
you are like me, I’d suggest removing it from the Dock and never using it. 

Mail is probably the program you will use more than any other. By default it has a new interface like that used 
in the iPad, which is OK, but you can use the Preferences-Viewing to restore a more classic layout. One 
little quick in that preference group; while it is indented and presumed only related to the use of the classic 
layout, you can turn on Show contact photos in the message list or show the To/CC label in the message 
list while still using the new layout. The new layout tends to make better use of the available space on a 
widescreen display by putting the optional preview pane on the right of the message list, instead of below 
it. Other than this fresh coat of paint, it’s pretty much the same as before in terms of its functions except 
you can now show threads or conversations as Apple calls them. This was a function added back in Lion. 
You will see a small number inside a box at the right margin of the message list showing how many 
threaded messages there are. They will each be shown in the preview pane on the right if we are using the 
new layout. If you are using the classic layout, there will be a triangle pointing to the right in the leftmost 
column. This column is only visible if showing conversations. Click the disclosure triangle to reveal the 
indented messages Mail believes are part of this conversation. It can get confused however if more than 
one set of emails happens to use the same subject. Still it’s a good function to have sometimes. I suggest 
modifying the toolbar to include the Conversations button to toggle this view on an off. The problem with 
it on is your latest message involved in a slightly stale conversation will not show at the top of the message 
list typically sorted by date and you may not notice the new message. There is a new iCloud IMAP style 
account you can add. This doesn’t really relate to Mountain Lion’s Mail program, but to address some 
long- standing shortcomings, you may consider adding these add-ons. Attachment Tamer version 3.1.9, 
which can force the sending of attachments like JPEG, images as icons and not embedded. There are plenty 
of dummies that don’t notice you can save attachments that are embedded anyway. Also Letter Opener 
version 5.0.4 which adds the ability for Mail to extract the files from attachments from a Exchange Server 
that come in as winmail.dat files. And finally consider DockStar, which modifies the Dock icon to show 
badges for multiple inboxes, not just one, for people with multiple email accounts. 

Messages replaces iChat but with better support for SMS type messages you may send to iOS devices, and not 
just the AIM style chat. 

Mission Control replaces Exposé and Spaces. 
Notes is new because the Notes you sync from your iOS device used to go to Mail and now you have to have 

another program open to check them. Makes some sense as they came from a discrete app in the first place, 
Preview is about the same as before. 
QuickTime Player is also the same as before. 
Safari 6.0.2 is new in that they merged the address field with the search field. Seems people kept typing in the 

wrong field. Google Chrome has had this for a while now. One of the most useful new tricks is the iCloud 
integration in Safari via the iCloud Tabs button in the toolbar. If you have other Macs running Mountain 
Lion or a iOS device running iOS 6, then whatever tabs are open there will show up here, under a heading 
for which device they go with. So if you find yourself browsing with your iPhone 5 and come across a web 
page that doesn’t work right, then jump on your Mac, use Safari and there is the web page link to that same 
page. Makes life a lot easier than having to email yourself a link. With recent attacks on computers with 
Java installed, Mountain Lion supports the new Java Runtime Environment 7 release 13, which fixes this 
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problem. Without this web sites that need java would stop working as Apple has remotely disabled the 
function without any visual clues. You might see Java in something like a coupon printing web site or a 
streaming presentation of your stock portfolio. Just the other day, Apple released a Java update 12 for Mac 
OS X 10.6.8 One of the step backwards in my opinion, is the way Safari 6 shows your downloads. It used 
to have a separate window you can leave open. Now it’s an icon in the toolbar you can click on to 
temporarily reveal your recent downloads. The icon shows the progress of your latest download. 

Stickies is not really updated. 
System Preferences we covered in plenty of detail in the last two presentations. 
TextEdit is new in that it prefers to open documents at startup, rather than create a new one like the older 

versions. It also likes to save them to iCloud, rather than to your Mac or local file server. Thee 
cultofmac.com web page details a simple Terminal trick to change this default behavior. It does like to 
share. Right there in the open dialog box, is the share button, where you can share your files via a email, 
message or AirDrop. Say you do create a new document, you may not notice at first but the title bar acts a 
little different. Start typing and it has auto-saved your document as Untitled.rtf and shows Edited. Click the 
title and you get a pop-up menu with these choices: 

 
Apple has included a versioning system, which can be rather nice if you use it. If you prefer the old manual 
method of doing a Save As… from the File menu, you are out of luck - it’s not there anymore. You have to 
duplicate the file and then save that. Still the program loads quick, so it’s good for recording things 
quickly, say while you are on the phone. The Preferences window has a bunch of useful things you can 
change. 

Time Machine: The changes in the backup part I’ve already covered in the System Preferences part. The 
restoration part, which is the application, is the same as before except you can choose which backup drive 
to restore from if you have more than one as set in the System Preferences panel. 


